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 POWER CORD. 

A power cord is an electrical cable that temporarily helps relay electrical signals from a power source to 

an electric appliance. 

A power cord, also known as an AC cord or mains cable, is a type of electrical cable used to connect 

electronic devices to a power source. It is designed to transmit electric current from a wall outlet to the 

device, providing the necessary power for its operation. 

 

Different types of power cords: 
Power cords could be of many types designed to match the functionality of an electrical device. Listed 

below are a few cords that are most commonly used by users: 

• Nema power cords: These heavy-duty power cords are known for their durability and usability. 

They come with long extensions that are capable of handling heavy-duty work such as gardening, 

assembly motors and minor construction works. In addition to this, Nema power cords are water-

resistant and coupled with sturdy prongs that are tough to bend or break. 

 

• Basic power cords: These power cords are suitable for all types of electric use. They are cheap and 

flexible to use with all major electronic operations. Basic power cords are sturdy enough to use them 

for any outdoor operations or small projects. 



 

 

 

• Small extension cords: For certain tasks, you only require smaller extension power cords. These 

cords are handy and used for a number of indoor and outdoor operations. Small extension power cords 

encourage a convenience that is ideal for your home, garden, office or any place else where you 

require a little more cord. 

 

• Long power cords: Generally, all the power cords come in full length. The essential factor to 

consider is that it must feature a lit plug so that even from a distance you know when it’s switched on. 

For more protection and rugged use, you can use double insulated conductors encased in a sheath or 

jacket. These do not wear off or crack even in extreme temperatures. 

 

 

POWER SWITCH 

A Power Switch provides an electrical connection from a voltage source or ground to a load. It saves 

power across multiple voltage rails and protects subsystems from damage. 

Types of Power Switches 

An electric switch will typically fall into one of two categories: 



1. Human-operated 

2. Machine-operated 

 

In either case, there are several variations on the normal. To narrow things down a little, we’ll focus on 

the types you’ll find in your home. 

 

Power Switches in Your Home 

Single-Pole: 

This single location switch consisting of two terminals is one of the most common types. Its simplistic 

design makes it popular for controlling lights or other devices. It is a simple “On/Off” switch and may 

display markings accordingly. 

 

 
 

Double-Pole: 

 

The double-pole is another single location switch used in high traffic areas. It is typically found in 

industrial settings but can be a helpful addition to the home as well. The controls are generally 30 amp 

rated, which is about double that of standard switches. 

This makes them useful when connected to high-demand appliances and machinery. Therefore, you 

might find them useful in your home workshop or garage if you use several power tools. 

 

 
 

 



Three-Way: 

The three-way switch is similar to the single-pole switch, except that you can control your lights from 

two different spots. You may, for example, have one switch at the bottom of the staircase and another at 

the top. This is a type of “On/Off” switch; however, it seldom has marks as these switches work 

opposite to another fixture. 

 

 

Four-Way: 

 

Four-way switches control your device or light from at least three areas. These are useful in large rooms 

with multiple entrances or long hallways. If you require more control from a set of three-way switches, 

you could place a four-way switch in between them. 

 

 

 

NETWORK CONNECTING CABLE 

Networking cable is a piece of networking hardware used to connect one network device to other 

network devices or to connect two or more computers to share devices such as printers or scanners. 

Different types of network cables, such as coaxial cable, optical fiber cable, and twisted pair cables, are 

used depending on the network's topology, protocol, and size.  



The devices can be separated by a few meters or nearly unlimited distances (e.g. via the interconnections 

of the Internet). 

 

1. Coaxial cable  

2. Optical Fiber cable 

3. Twisted pair cable 

1. Coaxial cable 

This cable contains a conductor, insulator, braiding, and sheath. The sheath covers the braiding, the 

braiding covers the insulation, and the insulation covers the conductor. 

The following image shows these components. 

 

Sheath 

This is the outer layer of the coaxial cable. It protects the cable from physical damage. 

Braided shield 

This shield protects signals from external interference and noise. This shield is built from the same 

metal that is used to build the core. 

Insulation 

Insulation protects the core. It also keeps the core separate from the braided shield. Since both the 

core and the braided shield use the same metal, without this layer, they will touch each other and 

create a short-circuit in the wire. 



Conductor 

The conductor carries electromagnetic signals. Based on conductor a coaxial cable can be 

categorized into two types; single-core coaxial cable and multi-core coaxial cable. 

A single-core coaxial cable uses a single central metal (usually copper) conductor, while a multi-

core coaxial cable uses multiple thin strands of metal wires. The following image shows both types 

of cable. 

\ 

2. Optical fiber cable 

  Optical fiber cabling is an excellent transmission medium for its high data capacity and supported 

long distances. It has a fiber/glass core within a rubber outer coating and uses beams of light rather 

than electrical signals to relay data. The fiber optic cables can run for distances measured in 

kilometers with transmission speeds from 10 Mbps up to 100 Gbps or higher due to the fact that light 

doesn't diminish over distance the way electrical signals do. 

 

 

 

3. Twisted-pair cables 

The twisted-pair cable was primarily developed for computer networks. This cable is also known 

as Ethernet cable. Almost all modern LAN computer networks use this cable. 



This cable consists of color-coded pairs of insulated copper wires. Every two wires are twisted 

around each other to form pair. Usually, there are four pairs.  

 

Each pair has one solid color and one stripped color wire. Solid colors are blue, brown, green, and 

orange. In stripped color, the solid color is mixed with the white color. 

Based on how pairs are stripped in the plastic sheath, there are two types of twisted-pair cable; UTP 

and STP. 

In the UTP (Unshielded twisted-pair) cable, all pairs are wrapped in a single plastic sheath. 

In the STP (Shielded twisted-pair) cable, each pair is wrapped with an additional metal shield, then 

all pairs are wrapped in a single outer plastic sheath. 

 

 
USB PORT  

A USB port is a standard cable connection interface for smart phones, computers, and other consumer 

electronics devices. USB stands for Universal Serial Bus, an industry standard for short-distance 

digital data communications.  

USB ports allow USB devices to be connected to each other with and transfer digital data over USB 

cables. They can also supply electric power across the cable to devices that need it.  

Both wired and wireless versions of the USB standard exist, although only the wired version involves 

USB ports and cables. 

 



 

Many types of consumer electronics support USB interfaces. These types of equipment are most 

commonly used for computer networking: 

 USB network adapters. 

 USB broadband and cellular modems for Internet access. 

 USB printers to be shared on a home network. 

For computer-to-computer file transfers without a network, USB drives are also sometimes used to 

copy files between devices. 

MOUSE OPERATIONS 

A Mouse can have several buttons, but when using a standard software application, you will only be 

using the two standard mouse buttons: left and right. The buttons on the mouse allow you to start 

programs, move objects from one place to another and change various settings without typing in 

complex text command.    

 

 

 



Single Click 

 A single click or "click" is the act of pressing a computer mouse button once without moving the 

mouse. Single clicking is usually a primary action of the mouse. Single clicking, by default in many 

operating systems, selects (or highlights) an object 

Right Clicking 

Right clicking refers to single clicking the right mouse button. In different applications, the  right button 

will offer different options and functionality.  

Right click on the desktop and select New. 

From the choices that appear, select the Folder option by moving the pointer over the word folder in the 

menu and clicking the left button. 

A new folder that you can rename will appear on your desktop. You might create a new folder if you 

would like to have a location to put all of your backup files. 

Dragging and Dropping 

To drag an object, select it by clicking your left mouse button on the picture, or icon, and holding it 

down. While still holding the mouse down, drag the icon to the new location. Release the button. 

 

KEYBOARD OPERATIONS 

The keys on your keyboard can be divided into several groups based on function: 

 Typing (alphanumeric) keys. These keys include the same letter, number, punctuation, and 

symbol keys found on a traditional typewriter. 

 Control keys. These keys are used alone or in combination with other keys to perform certain 

actions. The most frequently used control keys are Ctrl, Alt, the Windows logo key , and Esc. 

 Function keys. The function keys are used to perform specific tasks. They are labeled as F1, F2, 

F3, and so on, up to F12. The functionality of these keys differs from program to program. 

 Navigation keys. These keys are used for moving around in documents or webpages and editing 

text. They include the arrow keys, Home, End, Page Up, Page Down, Delete, and Insert. 

 Numeric keypad. The numeric keypad is handy for entering numbers quickly. The keys are 

grouped together in a block like a conventional calculator or adding machine. 

 



 

 

ICONS 

Icon is a small graphical representation of a program or file. When we double-click an icon, the 

associated file or program will be opened. For example, if we were to double-click on the My Computer 

icon, it would open Windows Explorer. Icons are a component of GUI. Icons help users quickly identify 

the type of file represented by the icon. 

Types of Icons 

 System Icons: 

System Icons are displayed along left edge of screen. These icons are created automatically by windows 

during its installation. Example of some system icons are My Computer, Recycle Bin, My Documents, 

Internet Explorer etc.   

 Shortcut Icons: 

These are the icons with small arrows in the lower left corner. A shortcut icons provides easy access to 

some objects on our systems, such as a program, a document or a printer. The shortcut icons only 

contain information about the location of the object but not the object itself.   



 Program folder and Document Icons: 

 These are non-system icons without arrows and they represent the actual objects they describe. So if we 

delete such an icon we are deleting the object itself, from the hard disk. 

 My Computer icon:  

My Computer is a Microsoft Windows feature first found in Windows 95 and included with all later 

versions that allows we to explore and manage the contents of our computer drives. The name My 

Computer icon in Microsoft Windows XP, Vista and Windows 7, as well as the "This PC" icon in 

Windows 8 and in Windows 10. Although the name has changed, "This PC" still has the same 

functionality as "My Computer." This icon lets we browse through all the resources attached to our PC. 

 

 

Recycle Bin  

 

Windows Recycle Bin is a special folder that stores deleted files from our computer or device, they are 

not permanently removed; they are first moved to this folder. The Recycle  

Bin Icon appears on the Desktop and looks like a waste paper basket. Windows does this as a precaution 

in case we deleted something by mistake. 

 

GUI 

GUI stands for Graphical User Interface. It refers to an interface that allows one to interact with 

electronic devices like computers and tablets through graphic elements. It uses icons, menus and other 

graphical representations to display information, as opposed to text-based commands. The graphic 

elements enable users to give commands to the computer and select functions by using mouse or other 

input devices. 



 

Basic Elements of a GUI: 

o Pointer: It is a symbol that appears on the display screen. It can be moved to select commands 

and objects. 

o Pointing device: It allows you move the pointer and select objects on the screen, e.g. mouse or 

trackball. 

o Icons: It refers to small images on the display screen that represent commands, files, windows 

etc. Using pointer and pointing device, you can execute these commands. 

o Desktop: It is the display screen that contains the icons. 

       BASIC COMPUTER OPERATIONS: 

A computer is an electronic device that can receive, store, process, and output data. It is a machine 

that can perform a variety of tasks and operations, ranging from simple calculations to complex 

simulations and artificial intelligence. 

Computers consist of hardware components such as the central processing unit (CPU), memory, 

storage devices, input/output devices, and peripherals, as well as software components such as the 

operating system and applications. 

Today, computers are widely used in various industries such as education, finance, healthcare, and 

entertainment, and they have revolutionized the way we live, work, and communicate. They have also 

given rise to a new era of technology such as the internet, cloud computing, and mobile devices, 

which have further transformed our daily lives. 

Computer is a device that transforms data into meaningful information. It processes the input 

according to the set of instructions provided to it by the user and gives the desired output quickly. A 

Computer can perform the following set of functions: 

 



 Accept data 

 Store data 

 Process data as desired 

 Retrieve the stored data as and when required 

 Print the result in desired format. 

 

 

 

1. Input: This is the process of entering data and programs in to the computer system. You should know 

that computer is an electronic machine like any other machine which takes as inputs raw data and 

performs some processing giving out processed data. Therefore, the input unit takes data from us to the 

computer in an organized manner for processing. 

2.  Storage: The process of saving data and instructions permanently is known as storage. Data has to 

be fed into the system before the actual processing starts. It is because the processing speed of Central 

Processing Unit (CPU) is so fast that the data has to be provided to CPU with the same speed.  

Therefore the data is first stored in the storage unit for faster Access and processing. 

 This storage unit or the primary storage of the computer system is designed to do the above 

functionality. It provides space for storing data and instructions.  

3. Processing: The task of performing operations like arithmetic and logical operations is called 

processing. The Central Processing Unit (CPU) takes data and instructions from the storage unit and 

makes all sorts of calculations based on the instructions given and the type of data provided. It is then 

sent back to the storage unit. 

 



4. Output: This is the process of producing results from the data for getting useful information. 

Similarly the output produced by the computer after processing must also be kept somewhere inside the 

computer before being given to you in human readable form. Again the output is also stored inside the 

computer for further processing 

5. Control: The manner how instructions are executed and the above operations are performed. 

Controlling of all operations like input, processing and output are performed by control unit. It takes 

care of step by step processing of all operations in side the computer. 

 

FILES: 

Definition of a File: A file is a container in a computer system that stores data, information, settings, or 

commands, which are used with a computer program. 

There are several types of files available such as directory files, data files, text files, binary and graphic 

files, and these several kinds of files contain different types of information. In the computer system, files 

are stored on hard drives, optical drives, discs, or other storage devices. 

LOCATING A FILE: 

How do you locate a file: 

Click the Start button, type the file name or keywords with your keyboard, and press Enter. The search 

results will appear. Simply click a file or folder to open it. 

 

OPENING A FILE: 

To open a file: 

1. Find the file on your computer and double-click it. This will open the file in its default application.  

2. Open the application, and then use the application to open the file. Once the application is open, you 

can go to the File menu at the top of the window and select Open. 

 

FILE EXTENSION: 

A file extension is an identifier that helps identify the type of file in operating systems, such as 

Microsoft Windows. It can be classified as a type of metadata, and it helps the operating systems to 

understand the intended use of a file and the characteristics. The filename extension may be contained 

one to four characters and used as a suffix to the file name. For example, in Microsoft Windows, the file 

extension is often followed by three characters. 



 

A dot (.) symbol is used to separate the file extension from the filename. The filename is considered 

incomplete without file extension; therefore, to complete a filename, it must be included in the file 

extension. Generally, file extensions are hidden from the users in Windows operating system. Although 

file extensions can be renamed, it is not necessarily by renaming a file extension will convert one file 

format to another. File extensions are helpful for both users and the file system in two ways: 

1. It helps in identifying the type of data that a file hold. 

2. It allows the operating system to select the proper program or application with which to open a 

file. 

Below is a table that contains common file formats you are most likely to see while working on a 

computer. 

 

File type 
File extension 

Image .bmp .eps .gif .jpg .pict .png .psd .tif 

Text .asc .doc .docx .rtf .msg .txt .wpd .wps 

Video .avi .mp4 .mpg .mov .wmv 

Compressed .arc .arj .gz .hqx .rar .sit .tar .z .zip 

Program .bat .com .exe 

Sound aac .au .mid .mp3 .ra .snd .wma .wav 

         

        PRINTING A DOCUMENT: 

1. Select File > Print. 

2. Choose the number of copies, and any other options you want, and select the Print button. 



Preview your document 

     1. Select File > Print. 

To preview each page, select the forward and backward arrows at the bottom of the page. 

 

If the text is too small to read, use the zoom slider at the bottom of the page to enlarge it. 

2. Choose the number of copies, and any other options you want, and select the Print button. 

 

 

CREATING A FOLDER/SUB FOLDERS IN A VOLUME ON HARD DISK AND 

DESKTOP: 

You can create a new folder at any location on your hard drive or within another folder (creating a 

subfolder) in File Explorer. You can also create a new folder on your desktop with this method. 2. Hold 

down the Ctrl, Shift, and N keys at the same time. 

 

Create a folder directly on the desktop 

Step 1: Right-click a blank spot on your desktop.  

Step 2: Move your cursor to New in the menu and pick Folder in the pop-out menu.  



Step 3: When you see the folder appear, the default name “New folder” is automatically selected so that 

you can just enter a name of your own. 

Create a subfolder 

 Click Folder > New Folder.  You can also right-click any folder in the Folder    Pane and click 

New Folder. 

 Type your folder name in the Name text box. ... 

 In the Select where to place the folder box, click the folder under which you want to place your 

new subfolder. 

 Click OK. 

          

         SHIFTING FILES FROM ONE FOLDER TO ANOTHER: 

Move a file in windows 

In Windows, files can be moved by using different methods such as cut and paste, drag-and-drop, or 

using the move to folder option. Below all methods are described through which you can move the files 

easily. You can choose any method accordingly. 

Cut and paste method 

To use the cut and paste method, first, you are required to select the file that you want to move. Then, 

right-click on the selected file and choose the cut option from the opened list. Now, open the destination 

folder where you want to move the file and right-click on the empty space in the folder and select the 

paste option from the list that appeared. 

On the other hand, select the file and click on the Edit option from the file menu and select 

the Cut option. Then, browse the folder where you want to move the files and click on the Edit option 

from the file menu and select the Paste option to move the file. 

Alternatively, you can also use shortcut keys to move the files. For that, you are required to highlight the 

file that you want to move, then press the shortcut key Ctrl+X. Now, browse the folder where you want 

to move the files and press the shortcut key Ctrl+V to paste the files. 

Drag-and-drop method 

First, you are required to select the files that you want to move, then hold down the right mouse button 

on the file, and drag the files while continuing to hold down the right mouse button, and release the 

mouse button on the location where you want to move the files. 

'Move to folder' method 

Highlight the file by clicking on the file name, then click on the Edit from the file menu and click the 

Move to Folder option. In the new window, browse the folder in which you want to move the files, then 

you only need to click on the move button to move the file to the browsed folder. 

 



SHUTTING OFF A COMPUTER: 

To turn off your PC in Windows 10, select the Start button, select the Power button, and then select Shut 

down. 

Steps to shutdown a computer. 

 Press the Start button. 

 When the start menu opens, select shut down. 

 Click OK when the shutdown box displays. 

 Turn the Monitor Off. 

 Turn the computer's CPU off. 

 Turn the main power button OFF. 



UNIT–II 

Internet: The Internet is a vast network that connects computers all over the world. Through the 

Internet, people can share information and communicate from anywhere with an Internet connection 

Internet can be accessed using following methods  

 Dial-up: This is generally the slowest type of Internet connection, and you should 

probably avoid it unless it is the only service available in your area. Dial-up Internet uses 

your phone line, so unless you have multiple phone lines you will not be able to use your 

landline and the Internet at the same time. 

 

 DSL: DSL service uses a broadband connection, which makes it much faster than dial-

up. DSL connects to the Internet via a phone line but does not require you to have a 

landline at home. And unlike dial-up, you'll be able to use the Internet and your phone line 

at the same time. 

 

 Cable: Cable service connects to the Internet via cable TV, although you do not 

necessarily need to have cable TV in order to get it. It uses a broadband connection and can 

be faster than both dial-up and DSL service; however, it is only available where cable TV 

is available. 



 

 Satellite: A satellite connection uses broadband but does not require cable or phone lines; 

it connects to the Internet through satellites orbiting the Earth. As a result, it can be used 

almost anywhere in the world, but the connection may be affected by weather patterns. 

Satellite connections are also usually slower than DSL or cable. 

 

 3G and 4G: 3G and 4G service is most commonly used with mobile phones, and it 

connects wirelessly through your ISP's network. However, these types of connections 

aren't always as fast as DSL or cable. They will also limit the amount of data you can use 

each month, which isn't the case with most broadband plans. 

 



Perform a Search Using a Web Search Engine 

Search engine – a web-based tool that is designed to search the content of web pages and find particular 

information on the Internet. 

Some popular search engines 

 Google 

 Bing 

 Baidu 

 Yahoo! 

 Yandex 

 Ask.com 

 DuckDuckGo 

Search the Internet using a Web Search Engine 

 Open a search engine in a web browser (such as Internet Explorer). 

 Type a few specific keywords or phrases in the search box to describe whatever you wish to 

search. Search engines look for the keywords in your query. 

 Press Enter. The search engine will display a list of websites (page after page) that include 

information related to your query. 

 Repeat above steps (type different keywords or phrases) if necessary. 

Browsers 

Browser – a software program that allows users to access and display websites or web pages 

(documents, images, videos, music, etc.) on the Internet. 

Some popular web browsers: 

 Google Chrome 

 Mozilla Firefox 

 Internet Explorer 

 Safari 

 Opera 



 

Google Chrome  

Google Chrome is a cross-platform web browser developed by Google. It was first released in 

September 2008 for Microsoft Windows. It has soon become the fourth-most widely used web browser 

in the present market share. The browser is also the main component of Chrome OS, where it serves as 

the platform for web applications. The browser options are very similar to that of Safari, the settings 

locations are similar to Internet Explorer 7, and the window design is based on Windows. Vista. 

Firefox  

Firefox is a new browser derived from Mozilla. It was released in 2004 and has grown to be the second 

most popular browser on the Internet. Mozilla Firefox or simply Firefox is a cross-platform, free and 

open-source web browser developed by the Mozilla Foundation. Firefox is available for Windows 7 or 

Windows 10, macOS, and Linux 

Internet Explorer  

Internet Explorer (IE) is a product from software giant Microsoft. This is the most commonly used 

browser in the universe. This was introduced in 1995 along with Windows 95 launch and it has passed 

Netscape popularity in 1998. 

Safari  

Safari is a web browser developed by Apple Inc. and included in Mac OS X. It was first released as a 

public beta in January 2003. Safari has very good support for latest technologies like XHTML, CSS2 

etc. 

Opera  

Opera is smaller and faster than most other browsers, yet it is full- featured. Fast, user-friendly, with 

keyboard interface, multiple windows zoom functions, and more. Ideal for new comers to the Internet, 

school children, handicap and as a front-end for CD-Rom and kiosks. 

 

How to Searching on the Internet.  

Now a days, a lot of information on the Internet. Search engines make this information easier to find. 

Let's look at the basics of using a search engine, as well as some techniques you can use to get better 

search results.  

After you run a search, you'll see a list of relevant websites that match your search terms. These are 

commonly known as search results. If you see a site that looks interesting, you can click a link to open 

it. If the site doesn't have what you need, you can simply return to the results page to look for more 

options.  

Search engines are good at finding things online, but they're not perfect. You'll often need to try 

different search terms to find what you're looking for. These will usually appear as you're typing, and 



they're a great way to find new keywords you might not have tried otherwise. To use a search 

suggestion, you can click it with your mouse, or select it with the arrow keys on your keyboard. 

 

How to register for a web-based E-mail account 

EMAIL: 

Email stands for electronic mail, e-mail or email is information stored on a computer that is exchanged 

between two users over telecommunications. More plainly, e-mail is a message that may contain text, 

files, images, or other attachments sent through a network to a specified individual or group of 

individuals.  

Email operates across computer networks, primarily the Internet. Today's email systems are based on a 

store-and-forward model. Email servers accept, forward, deliver, and store messages.  

Gmail is free and simple to use. You can sign up for Gmail and use it in any web browser, or 

download the Gmail app for your iPhone, Android phone, or tablet. To create a Gmail account, 

visit https://accounts.google.com/signup.  

From there: 

  1. Enter your first and last name. 

  2. Type in your chosen username. This will be the first part of your email address (the part that comes 

before @gmail.com). 

  3. Enter your password, then type it again in the Confirm box. 

4.Your password must be at least 8 characters long and contain a mixture of letters, numbers, and other 

symbols. 

5.Click Next. 

6. If you like, enter a recovery email address and phone number in case you get locked out 

of your new email address. These steps are optional. 

7. Enter your birthdate and gender. 

8. Click Next again. 

9. Review the terms and services and click I Agree. 

10. Enjoy your new free Gmail account! 

 Subject. Subject is a description of the topic of the message and displays in most email systems 

that list email messages individually. A subject line could be something like "2010 company 

mission statement" or, if your spam filtering application is too lenient, "Lose weight fast!!! Ask 

me how."  

 Sender (From). This is the sender's Internet email address. It is usually presumed to be the same 

as the Reply-to address, unless a different one is provided.  

https://www.wikihow.com/Create-a-Gmail-Account
https://accounts.google.com/signup
https://www.wikihow.com/Create-a-Cool-Email-Address


 Date and time received (On). The date and time the message was received.  

 Reply-to. This is the Internet email address that will become the recipient of your reply if you 

click the Reply button.  

 Recipient (To:). First/last name of email recipient, as configured by the sender.  

 Recipient email address. The Internet mail address of the recipient, or where the message was 

actually sent.  

 Attachments. Files that are attached to the message  

 

Replying to an Email: 

1. Replying to an Email: 

Replying to emails has now become even easier, especially with the development of mobile 

applications, to make it more convenient to reply to emails. Here are the steps to follow to reply to an 

email using the application on your mobile device: 

 Click on the application icon on your device. 

 Scroll through messages and select the email to send a response. 

 Open the email and find the reply icon at the top or bottom of the page. 

 Click on 'Reply' and type in your email. 

 Send 

2. Using the web version: 

When using the web version, either on your phone or computer, the options to reply may differ. Review 

the steps to learn how to reply using this version: 

 Login to your account through your browser. 

 Click on your inbox and scroll to get to the email. 

 Open the email and find the 'Reply' icon on the page. 

 Click on 'Reply' and type in your email. 

 Send. 

 

To forward an email message: 

1. While viewing the message, click Forward at the bottom of the message. You can also         

select Forward from the More drop-down menu next to the Reply arrow. 

  2. Type the recipient's email address in the To: field, or click To to choose a recipient from your 

contacts. If the person is in your contacts, you can start typing his or her name and that contact's 

email address should appear. 

  3. Type your message in the Body field, and then click Send. 



How to Attach Files to Your Gmail Emails? 

    The different types of attachments you could send inside the email are: 

Document or DOCX: For sending text documents with snapshots. For instance, use Microsoft Word 

and Google Docs. 

PDF: Sending a formatted text with photos that the recipient can easily get access to, irrespective of 

the operating system, application software, and hardware. 

PPT or PPTX: Send slideshows and presentations in this format. 

XLS: For sending a database in a row and column format. For instance, Excel sheets or Google Sheets 

files 

PNG, JPEG, or GIF: Use this format to send static and animated pictures. 

The steps to writing an email and attaching files are similar among email clients, with few 

differences. Below, we will go over how to write and send email with attachments in Gmail. 

Send a File Attachment With Gmail 

To attach a file to an email sent from Gmail, follow these steps: 

Step 1: Select “Compose” to write a new email message or reply to a message you received.  

Step 2: On the message window, click the Attach Files paperclip icon. An open dialog box opens. 

Step 3: Select the document(s) you need to send and choose Open. The file(s) will be attached to the 

email message. 

Step 4: Select the Attach Files paperclip once more if you need to add more files from another place. 

Send the email when you’re ready. 

Adding Attachments Quickly by Dragging and Dropping. 

To add a file to a Gmail message as an attachment, use dragging and dropping. Here check for drag 

and drop files to send email with attachments in Gmail through steps: 

Step 1: Start with a new message. 

Step 2: Locate the file you want to attach in your file browser (for example, File Explorer). 

Step 3: Click the file with the left mouse button, and, keeping the button pressed, drag over the 

browser window with the email you are composing. 

Step 4: Drag the file to the section that lights up with the message. 

Step 5: If you don’t see such an area, your browser does not support drag-and-drop attachments. For 

more information on attaching files in Gmail, see the instructions above. 

Step 6: Release the mouse button to drop them here. The file is connected to the message. Click on 

the send button to send the email when you’re ready. 

 

 

 

 



Send Google Drive Attachments in Gmail. 

If the file(s) you want to send in a Gmail message are saved on Google Drive, you have the choice of 

sending them as an attachment or sending a link. 

Step 1: Select Compose to write a new email message or reply to a message you received. 

Step 2: Choose the Google Drive icon in the message window to insert documents using Google 

Drive. A new window opens. 

Step 3: Select the file(s) you need to send and choose the way you want to attach them by deciding on 

Drive Link or Attachment at the bottom of the window. 

Step 4: Any documents stored in Google Drive can be sent as links. Only documents that were not 

created using Google Docs, Sheets, Slides, or Forms can be dispatched as attachments. 

Step 5: Select Insert and send your message. 

 

How to Delete an Email message 

I. Single message in Gmail 

On Desktop 

Step 1: Sign in to your Gmail account on your computer. 

Step 2: Open the email you want to delete. 

Step 3: Click on the bin icon to dispose of this message. 

 

On Mobile 

Step 1: Open the Gmail app on your Android or iOS device. 

Step 2: Tap on the email you want to delete to open it. 

Step 3: Tap the trash icon to remove this email from your Gmail account. 

https://mail.google.com/mail/u/0/#inbox


II.Multiple emails in Gmail 

But let’s be honest. If you have dozens of old emails, deleting them one at a time ends up being very 

time-consuming. So, how about we speed things up a bit? Here’s how you can delete multiple emails at 

once in Gmail. 

On Desktop 

Step 1: Go to Gmail. 

Step 2: Select multiple emails. 

Step 3: Then press “Delete” to remove them. 

 

On Mobile 

Step 1: Open Gmail on your phone. 

Step 2: Select multiple emails by tapping on the sender’s profile picture or the first letter of their 

username. 

Step 3: Once you’ve selected the emails you want to get rid of, tap on the bin icon to delete them from 

your Gmail account. 

 

 

 

https://mail.google.com/mail/u/0/#inbox


UNIT-III 

What is utility bill. 

A utility bill is paid at the end or start of a month in exchange of a utility used. The bill is technically 

an invoice issued by authority providing the utility. 

Here’s a list of utility bills for you to understand. 

Electricity Bill 

One of the most important utilities is electricity. You require electricity for lighting, cooling, heating 

and refrigeration, computers, electronics, machinery, and public transportation systems. The electricity 

usage is tracked by a meter that records the rate of the electricity consumed. Every month the 

calculated rate gets reflected in your electricity bill that you have to pay it consistently. Negligence of 

light bill payment will lead to severe consequences. Firstly, you will be provided a notice period of 15 

days to pay your dues, or it might result in termination of your electricity connection. 

Water and Sewage Bill 

Most homes get water supplied from the town, piped into their homes, and drained into public sewer 

lines. The water is usually pumped from lakes, larger wells, and reservoirs which get treated by a 

filtration system for consumption. So, the water and sewage bill covers the cost of the complete 

process from start to end. For an uninterrupted water supply, you must pay your utility bill on time. 

Gas Cylinder Bill 

Gas cylinder is used in almost every house in India. Numerous natural gas suppliers provide home 

delivery of gas cylinders for domestic purposes. These cylinders are hazardous and need to be handled 

with proper care and maintenance. Nowadays, gas services have become convenient due to the online 

payment feature. You can swiftly make gas cylinder online payment via Airtel Payments Bank on the 

Airtel Thanks App. 

Internet and Phone Services 

To use your phone, you need to get your mobile services started. You can choose from various telecom 

companies that offer great deals on phone plans. If you want a want to avail exciting recharge offers, 

you can get Airtel prepaid or postpaid plan for your mobile. By recharging via the Airtel Payments 

Bank, you can avail cashback and discount coupons on your online transactions. 

Now that you have learnt what comes under utility bills, learn how to pay utility bills in India online. 

 

 



How to Pay Utility Bills Online. 

Mentioned below are the steps to make online bill payment with the Airtel Payments Bank. 

Light Bill Payment 

 On the Airtel Thanks App, visit the Payments Bank Section. 

 Click on ‘Electricity Bill’ and select your state. 

 Select your operator and fill in your CA number. 

 Click on ‘Pay Now’ and select the preferred payment method. 

 Proceed ahead to complete your light bill 

Gas Cylinder Online Bill 

 Login to the Airtel Thanks App 

 Select the ‘Pay Bills’ option and tap on the ‘Gas’ option 

 Choose the gas service operator and fill in the BP number mentioned in the bill 

 Complete the bill payment process by clicking on ‘Pay Now’. 

Mobile Bill Payment 

 Login to the Airtel Thanks App and tap on ‘Recharge’. 

 Select the ‘Mobile Recharge’ option and enter the number you want to recharge. 

 Choose your respective operator and click on ‘Pay Now’. 

 Pick the mode of payment to complete the transaction. 

 Verify the OTP sent to your mobile and proceed. 

How To Book Bus Tickets 

Bus booking can be done through various options both online and offline 

How To Book A Bus Ticket Online. 

1. Through State Road Transport Corporations 

Step 1: Go to the official website of the Road Transport Corporation 

Step 2: Enter the source and destination cities, departure date, and round trip date 

Step 3: Check for available buses. 

Step 4: After viewing the details of the buses such as dropping points and boarding points, number of 

seats, price of a ticket, duration of the journey, etc. select the appropriate bus 

Step 5: Proceed with the rest of the instructions to book the tickets 

 

2. Through the E-Ticketing Platform 

Step 1: Go to the official website of the online bus ticket booking service. Users can visit any e-ticket 

booking platform, such as AbhiBus, redBus, Paytm, Make My Trip, etc. 



Step 2: Enter the city you are going to leave from, destination city, departure date, and other required 

preferences. 

Step 3: Search for the buses available 

Step 4: After viewing the details of the buses available, such as departure time, arrival time, total 

duration of the journey, boarding points and dropping points along the route, price per ticket, number 

of seats left, and other relevant information, select the appropriate bus. 

Step 5: Proceed with the rest of the instructions to book the tickets. 

 

3. Through the Mobile App of the E-Ticketing Platform 

Step 1: Download the preferred mobile app from Google Play Store or App Store. 

Step 2: Create an account by entering your mobile number 

Step 3: Authenticate your account by entering the OTP sent to your mobile 

Step 4: You will be redirected to the home page of the e-ticketing app 

Step 5: Enter the city from which you are leaving, the destination city, the departure date, and other 

required preferences. 

Step 6: Search for the buses available. 

Step 7: You can now view the details about the buses, such as departure time, arrival time, duration of 

the journey, and the bus fares will be displayed. 

Step 8: Select the bus and proceed with the rest of the instructions to complete the ticket booking. 

 

How To Book A Bus Ticket Through Other Options 
 

 Through bus ticket counters: Visit the bus station or authorised booking counter to purchase 

tickets in person. This is a reliable option, especially if you prefer paying in cash. 

 Authorised agents: Many travel agencies and agents offer bus ticket booking services. You 

can approach them to book your tickets and get information about available routes and 

schedules 

Benefits of Online Bus Ticket Booking 

 Online bus ticket booking is convenient and hassle-free. 

 It keeps you away from the long queues of offline ticket counters 

 No more hassle of contacting travel agents. 

 24/7 customer support 

 You can view plenty of buses and pick out an appropriate bus travelling by reviewing the 

amenities, boarding and dropping points, reviews, ratings, and bus images available. 

 You can book both private and SRTC bus tickets online. 

 You can choose the preferred bus type (Volvo Bus, AC or Non AC), timings, and also pick up 

and drop points 



 Your tickets can be booked at an economical price with the existing bank and e-wallet 

discounts. 

 Access to discounts from payment partners and cashback offers. 

Here are the steps you need to follow to get a train ticket from the Indian Railways booking 

counter: 

For booking a train ticket through Indian Railways booking counter, you have to visit the nearest 

railway station and ask for the reservation form. 

 Fill the passenger details (Like: Name/s, age, gender, berth preference) 

 Once you are  done with form return it to the booking counter with payment 

 And you will get your tickets with the unique PNR number! 

You can do online train tickets booking by logging into the IRCTC (a subsidiary of the Indian 

Railways) website directly or by seeking help from licensed IRCTC agents 

 After that, you have to select the source and destination stations 

 Select your preferred train 

 Check for train ticket availability 

 You have to fill the passenger details (Like: Name/s, age, gender, berth preference and meal 

preference) 

 After completing all the personal details, proceed towards payment 

 Fill the details required at the time of payment 

 Your online train ticket booking is finalised once the payment is made 

A message or email will be sent to the passenger's registered details 

Other than it the government has taken many measures to strengthen the online ticket reservation 

system, including the Tatkal scheme. 

Passengers do not have to input any ID card details during the train ticket booking session. However, 

the passenger(s) needs to carry and show one of following identity card during their journey. The 

original ID card is required for validation purposes. 

Following ID cards are considered valid by Indian Railway: 

 Aadhar card 

 Voter photo identity card 

 Passport 



 Driving License 

 Pan Card 

 The central/state government issued Photo Identity card 

 Student Identity Card with photograph 

 Nationalized Bank Pass Book with photographs 

 Credit Cards with laminated photograph 

 Photo identity cards having serial number 

Definition of bank transaction 

A bank transaction is any money that moves in or out of your bank account. Types of bank 

transactions include cash withdrawals or deposits, checks, online payments, debit card charges, wire 

transfers and loan payments. 

Three main types of bank transactions: 

The three main types of bank transactions are deposits, withdrawals, and transfers. Deposits put money 

into an account, withdrawals take money out, and transfers move money between accounts. 

ATM and Debit Card Transactions: When cash is withdrawn from the bank’s ATM, then the cash 

withdrawal transaction is recorded in the customer’s account as a debit transaction on a real-time 

basis.  

Branch Transactions: These transactions include payments and withdrawals. Branches pay for 

overheads and other miscellaneous payments through bank accounts.  

Check Clearing Transactions: A customer may deposit a check in their bank, which is first lodged 

for clearing and then credited to the relevant customer’s account after completing the necessary 

clearing process. 

Fund Transfers: This includes transferring funds from one account to another. This transaction may 

be between two individuals, an individual and a company, or between two companies or entities. 

Funds may be transferred outside the country to another bank’s account, or the funds may be received 

from another country as a home remittance.   

Online Bill Payments: Residents make payments through their personal accounts to settle their 

monthly or periodic bills. 

         How to withdraw money from ATM? 

 Step 1: Insert ATM Card: 

 Step 2: Select Language 

 Step 3: Enter 4-Digit ATM Pin: 

 Step 4: Select the type of Transaction: 

 Step 5: Select the Type of Account: 

 Step 6: Enter the withdrawal amount 
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 Step 7: Collect the Cash: 

 Step 8: Take a printed receipt , if needed: 

 Step 9: Another Transaction: 

Personal transactions 

Personal transactions occur when employees or businesses spend money for personal reasons. For 

example, a department throwing a birthday party for one of their employees is a personal transaction. 

Some companies require employees to pay for their own personal transactions, while others offer a 

certain amount of money for personal use. 

 receiving cash or credit from a customer for selling them a product or service 

 borrowing funds from a creditor 

 purchasing products from a supplier 

 investing in another business 

 paying off borrowed funds 

 paying employees their salary 

Job search through employment portals 

LinkedIn: 

To search for jobs: On Desktop 

1. Click the Jobs icon at the top of your LinkedIn homepage. 

2. Click into the Search bar on the top of the page and search by keywords, title, skill, or a 

company name. 

o You can also select from the job roles suggested by LinkedIn based on your 

qualification and experience. Please make sure that you’ve updated your LinkedIn 

profile with your experience, education, and other information. 

o You’ll be directed to the search results page where you’ll see a list of job postings that 

suit your job role and location preference. 

3. Use the filters options at the top of the search results page to filter the results. 

Note: Once you’ve applied all the filters, you can switch on the Set Alert toggle and set job 

alerts. 

4. Click the job posting to view the job description and apply for the job if the job suits your 

requirement. 
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To search for jobs: On Mobile 

1. Tap the Jobs icon. 

2. Type the keywords in the Search jobs field and preferred job location in the Location field. 

3. Tap Search. 

4. Use the filters at the top of the search results to refine the results. 

5. Tap the job posting to view the job description and apply for job if the job suits your 

requirement. 

6. To apply for a job through your mobile device, tap Easy Apply or Apply (options may vary) at 

the top of the job post and follow the prompts. 

7. Tap Save to save a job post. 

To view your saved jobs and manage your job search most effectively, we recommend downloading 

the LinkedIn mobile app or accessing it via desktop. You may find it easier to complete your 

application on your computer. 

Naukari: 

To search for jobs: On Desktop: 

1. Go to Naukri.com and click on the search bar at the top 

2. In the search bar, type a keyskill, job designation or company name. You can also use Boolean 

search to refine your search query. 

3. You can type multiple terms in the search bar. An example would be search as “java, 

javascript, software engineer” which combines both keyskills such as ‘java’ and ‘javascript’ 

with the designation ‘software engineer’. This would look for all three terms to display job 

listings. 

4. Type the location where you would like to get a job in the location field. Select the work 

experience in years for which you want to see jobs in the work experience field. Select the 

minimum salary for which you would like to see jobs. 

5. Click Search 

6. Use filters such as Top Companies, Industry, Salary range, Location, Education, Employer 

type (posted by company or hiring consultancy), Job Type (International, Premium, Walk-in)  

7. And Freshness (how long ago the job was posted) to get more accurate results. These are found 

on the left side of the search results. 

8. You can click the Sort by dropdown at the top of the search results to sort either by relevance 

or by the date when the job was posted. 

9. Click a job listing to view more details about the job 

10. Click Apply or Apply on Company Website to apply for the job. 



To search for jobs: On Mobile 

1. Tap the search icon in My Naukri Home page to go to Search Jobs page 

2. In the search bar, type a keyskill, job designation or company name. 

3. Type the location where you would like to get a job in the location field. Select the work 

experience in years for which you want to see jobs in the work experience field. Select the 

minimum salary for which you would like to see jobs. 

4. Tap Search Jobs 

5. Tap the filter icon at the bottom corner to filter and sort the results. You can sort by relevance 

or job posted date. You can use filters such as employer type, location, education, industry, 

salary and job type. 

Tap a job posting and click Apply or Apply on Company website button to apply to the job. 

Applying on company website will take you outside Naukri to the company’s website. 

DTH recharge 

A lot of recharge platforms provide the service of DTH recharge online including Paytm. Here are the 

steps that you need to follow-  

On Paytm Mobile Application 

 Open Paytm mobile application on your mobile phone 

 Click on ‘Recharge & Pay Bills’ 

 Click on ‘DTH’ 

 Click on ‘New DTH Recharge’ 

 Select your DTH operator 

 Enter your details such as Customer ID, Registered Mobile Number, Smart Card Number etc. 

 Enter your recharge amount 

 Click on ‘Proceed to Recharge’ 

 Select your preferred mode of payment such as Debit Card, Credit Card, Paytm Wallet, Paytm 

Postpaid and Net Banking 

 Complete your payment and you will be done! 

On Paytm Web 

 Go to the ‘DTH Recharge‘ page on Paytm’s official website 

 Select your DTH operator 

 Enter your details such as Customer ID, Registered Mobile Number, Smart Card Number etc. 

 Enter your recharge amount 

 Click on ‘Proceed to Recharge’ 

https://paytm.com/dth-recharge


 Select your preferred mode of payment such as Debit Card, Credit Card, Paytm Wallet, Paytm 

Postpaid and Net Banking 

 Complete your payment and you will be done! 

You get a notification on your registered mobile number and email address as soon as you make the 

payment to confirm your order.  

Benefits of Making DTH Recharge Online on Paytm 

Here are some of the most common benefits of recharging DTH online on Paytm- 

 Paytm saves your details so that you don’t have to enter the DTH details every time you want 

to make a DTH recharge on Paytm 

 Paytm offers a safe and fast mode of DTH recharge 

 You can get cashbacks and vouchers to save money on your DTH recharge on Paytm 

 Paytm sends you reminders for your next DTH recharge so that you don’t forget about it and 

you can enjoy your DTH connection without interruption 

Online Mobile Recharge from Paytm Website 

Paytm is an Indian financial technology and e-commerce company that offers a wide range of services, 

including online mobile recharge. To recharge a mobile phone from the Paytm website, the user needs 

to follow these steps: 

1. Go to the Paytm website ( https://paytm.com/) and log in to their account. If the user does not 

have an account, they can create one by clicking on the “Sign Up” button and following the on-

screen instructions. 

2. Then, next navigate to ‘Recharge and Pay Bills.’ 

3. On the next page, the user needs to enter their mobile number, select their mobile phone 

operator, and choose the amount of credit or data they want to add to their balance. 

4. After selecting the recharge amount, the user can review the details and choose a payment 

method. Paytm accepts various payment methods, including credit and debit cards, net banking, 

and Paytm Wallet. 

5. Once the payment is processed, the credit or data will be added to the user’s mobile phone 

balance, and a confirmation message will be sent to their registered email address and mobile 

number. 
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Online Mobile Recharge from Paytm Application 
 

Paytm also offers an application for mobile devices that allows users to recharge their mobile phones from 

their smartphones or tablets. To recharge a mobile phone from the Paytm app, the user needs to follow 

these steps: 

1. Open the Paytm app and log in to their account. 

2. Go to ‘Recharge & Bill Payments’ and select ‘Mobile Recharge.’ 

3. On the next page, the user needs to enter their mobile number, select their mobile phone 

operator, and choose the amount of credit or data they want to add to their balance. 

4. After selecting the recharge amount, the user can review the details and choose a payment 

method. Paytm accepts various payment methods, including credit and debit cards, net 

banking, and Paytm Wallet. 

5. Once the payment is processed, the credit or data will be added to the user’s mobile phone 

balance, and a confirmation message will be sent to their registered email address and mobile 

number. 

Advantages of Paytm Online Mobile Recharge 

Paytm offers several advantages for users who want to recharge their mobile phones online, including 

 Convenience: Paytm allows users to recharge their mobile phones from the comfort of their 

own homes or anywhere else with an internet connection. This eliminates the need to visit a 

physical store or use a scratch card to top up their balance. 

 Speed: Paytm’s online recharge process is quick and easy, allowing users to add credit or data 

to their mobile phone balance in just a few minutes. 

 Payment options: Paytm accepts a wide range of payment methods, including credit and debit 

cards, net banking, and Paytm Wallet. This gives users the flexibility to choose the payment 

method that suits them best. 

 Promotions and discounts: Paytm often offers promotions and discounts on mobile phone 

recharges, allowing users to save money on their mobile phone expenses. 

 Security: Paytm uses secure encryption technology to protect users’ personal and financial 

information. This ensures that the online recharge process is safe and secure. 

Word processing   

The use of a program (software application) running on a computer that allows users to create, edit, format, and store 

documents. 

How to open MS Word in Windows? 

In Windows 8/above: 

Step 1: Press Windows + C to open the search bar 

https://opentextbc.ca/computerstudies/chapter/basic-word-processing-2/#term_281_463


 

 
 
Step 2: Type MS Word & click on the MS Word version you are having in your system. MS Word 

window will pop up. 

In Windows 7 or below: 

Step 1: Go to the program section in the windows start menu. 

Step 2: Go to MS Office & click on it. A drop-down list is seen 

Step 3: Click on MS Word & the MS Word window will pop up. 

Create a Document 

Steps to create a new word processing document (Word, Office 365): 

1. Start Microsoft Word. 

2. Click the File tab. 

3. Click the New tab. 

4. Click Blank document. (A new blank document appears.) 

5. Type your text. The text you type will be inserted into the document. 

 



Edit a Document 

Editing a document – making revisions to a document, focusing on correcting errors, improving the 

accuracy of language, rearranging, making words and sentences clearer and more effective, etc. 

Editing in word processing may include the following tasks: 

 Adding text (terms, phrases, paragraphs, etc.) 

 Deleting a part of a text 

 Copying text 

 Moving text 

 Pasting text 

 Checking for grammar and spelling 

 Formatting text 

How to Save a document or give a Name to a new document created? 

Step 1: Click on the Microsoft icon 

Step 2: Click On SaveAs button. 
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Step 4: Select the drive (by clicking on it: Example: Local Drive (D)) in which you want to save the 

document 

Then your driver will open up, select the folder in which you want to save the document (Example: 

img folder here) & then give the required name to your document (Example: Doc3 here) 

Your document is created & saved with the provided name. 

Note: Shortcut for save: Ctrl +s 

How to print a document through an attached printer? 

Step 1: Click on the Microsoft icon 

Step 2: Click On Print & a window for Print & Preview the document will pop up. 

 

Step 3: Click on Print. Then a window for Print will pop up. 

 

Step 4: Select the printer by which you want to take out a print of the document. Select the page 

range (Print of all or some or current page) & the number of copies you want. 

Step 5: Click on OK. You will get a print of your document. 



FORMATTING TEXT 

In MS Word there are multiple types of formatting we can apply to a given text such as Fonts, Font 

Styles, Font Colors, Font Sizes, Text Highlight Colors, Clearing Formats, Change Cases, etc. 

Let us apply these techniques to some texts in the Word Processor and see what result it produces.  

Font 

Fonts are used to change the display of the text or Word Document, look more appealing, and as per 

the requirement of the situation. There are multiple types of fonts available in MS Word-

like: Calibri, Times New Roman, Algerian, Arial, Century, etc. 

Steps to Apply: 

Step 1: Select the text you want to change the font of. 

 

Step 2: Now, select the font of your choice from the Home menu bar in MS Word. 

 

 

 

Result: 

 

 



Font Style 

Font Styles are used to change the Look ability of the text or give more emphasis on some texts in 

the Word Document. There are three types of font styles in MS Word: Bold, Italics, and Underline. 

Steps to Apply Bold Font Style: 

Step 1: Select the text you want to change the Font Style. 

 

Step 2: Now, select the Font Style of your choice from the Font Style bar under the Home menu 

bar.  

 

 
Result: 

 

Steps to Apply Italics Font Style: 

 

Step 1: Now, select the Font Style of your choice from the Font Style bar under the Home menu 

bar.  

 



 

 

Result: 

 

Steps to Apply Underline Font Style: 

Step 1: Now, select the Font Style of your choice from the Font Style bar under the Home menu 

bar. 

 

 

Result: 

 

You could also use the shortcuts like: 

 CTRL+B for Bold 

 CTRL+I for Italics 

 CTRL+U for Underline 

Font Color 

Font Colors have wide use in real life when using the Word Document. Be it highlighting the main 

points of the document or want to convey some important information. There are multiple types of 

Font Colors available in MS Word-like: Red, Blue, Yellow, Orange, Light blue, etc. 

Steps to Apply: 



Step 1: Select the text you want to change the Font Color. 

 

 

Step 2: Now, select the Font Color of your choice from the Font Color bar under the Home menu 

bar. 

 

 

Result: 

 

Font Size 

Font Sizes are used to display the text in the Word Document larger or smaller according to our 

needs. We generally display a heading with a Font Size of 15, Subheadings with a Font Size of 14 or 

13, and paragraphs with a Font Size of 12. Many Font Sizes are available in MS Word-like: 8, 9, 10, 

11, 12, 14, 16, etc. 

Steps to Apply: 

Step 1: Select the text you want to change the Font Size. 

 

Step 2: Now, select the Font Size of your choice from the Font Size bar under the Home menu bar. 



 

 
 

Result:  

Text Highlight Color 

As the name itself suggests, the Text Highlight Color is used to highlight text in the Word 

Document. There are many Text Highlight Colors available in MS Word-like: Yellow, Bright Green, 

Turquoise, Pink, Red, etc. 

Steps to Apply: 

Step 1: Select the text you want to change the Highlight Colors. 

 

Step 2: Now, select the Color of your choice from the Text Highlight Color bar under 

the Home menu bar. 

 
 

 



 

Result: 
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